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1  Welcome to the Hardware in the Loop (HIL)
Option
The term hardware in the loop (HIL) describes the mode in which the R&S SMW is
remotely controlled by control application software (see Figure 1-1). The control appli-
cation software sends remote commands over LAN in real time, possibly from a motion
simulator. The R&S SMW processes the received position, motion and attitude infor-
mation and generates the required signal.

The output GNSS signal is sent to system under test, that typically includes a GNSS
receiver forwarding the calculated position to the application software. The application
software can use the retrieved position for display purposes (such as infotainment plat-
form in a vehicle) or to control the actual position of the vehicle (e.g. auto-pilot).

Figure 1-1: Example of HIL test setup

Refer to the following sections, for definition of the terms used in the context of HIL
testing and settings. The description also gives recommendations on working with the
R&S SMW in HIL setups.
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1.1  Accessing the GNSS HIL Dialog

To open the dialog with HIL settings

1. In the block diagram of the R&S SMW, select "Baseband > GNSS".

2. Select "GNSS > Simulation Configuration > Receiver"

3. Select "Position" > "Remote Control (HIL)".

4. Select "Position Configuration".

A dialog box opens that displays the provided HIL settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.2  What's new

This manual describes firmware version FW 5.30.047.xx and later of the
R&S®SMW200A and R&S®SMBV100B.

Compared to the previous version, it provides editorial changes only.

1.3  Documentation overview

This section provides an overview of the R&S SMW user documentation. Unless speci-
fied otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smw200a

1.3.1  Getting started manual

Introduces the R&S SMW and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.3.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-

Documentation overview

http://www.rohde-schwarz.com/manual/smw200a
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mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMW is not included.

The contents of the user manuals are available as help in the R&S SMW. The help
offers quick, context-sensitive access to the complete information for the base unit and
the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.3.3  Tutorials

The R&S SMW provides interactive examples and demonstrations on operating the
instrument in form of tutorials. A set of tutorials is available directly on the instrument.

1.3.4  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.3.5  Instrument security procedures

Deals with security issues when working with the R&S SMW in secure areas. It is avail-
able for download on the internet.

1.3.6  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.3.7  Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMW. It also lists the
options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smw200a

Documentation overview

https://gloris.rohde-schwarz.com
http://www.rohde-schwarz.com/brochure-datasheet/smw200a
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1.3.8  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The software makes use of several valuable open source software packages. An open-
source acknowledgment document provides verbatim license texts of the used open
source software.

See www.rohde-schwarz.com/firmware/smw200a

1.3.9  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smw200a and www.rohde-schwarz.com/
manual/smw200a

1.3.10  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

Figure 1-2: Product search on YouTube

Documentation overview

http://www.rohde-schwarz.com/firmware/smw200a
http://www.rohde-schwarz.com/application/smw200a
http://www.rohde-schwarz.com/manual/smw200a
http://www.rohde-schwarz.com/manual/smw200a
https://www.youtube.com/@RohdeundSchwarz
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1.4  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMW user manual.

1.5  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots
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2  Tips for best results
We recommend that you consider the following measures.

Measures for proper operation

1. Synchronize the R&S SMW and the motion simulator.
(see Chapter 2.1, "Synchronization", on page 10).

2. Take measures for latency calibration.
(see Chapter 2.3, "Latency calibration", on page 11).

3. Add additional buffer time.
Chapter 2.4, "Adding a constant delay to compensate for command jitter",
on page 13

4. If the first position fix and the latency calibration are successful but during the
motion simulation the receiver loses its position fix, try out the following:

a) Analyze the sent HIL data.

● Evaluate the trajectory smoothness and search in particular for unwanted
abrupt positions changes ("jumps").

● Send HIL commands with lower update rate, for example each 100 ms.
Reducing the update rate leads to interpolation and thus spreads the
severity of the "jumps" over several 10 ms update intervals.
See Chapter 2.5, "Interpolation", on page 15.

b) Avoid abrupt positions changes.
The motion simulator itself can cause position changes. Consult the specifica-
tion of the used receiver for information on the high-order dynamic stress it is
able to handle.

The measures for proper operation use the SCPI interface and the R&S SMW is in
remote state. Switch to manual state after you finish the measures, if the R&S SMW
retrieves HIL position data via UDP packets.

2.1  Synchronization

To process the HIL commands, the R&S SMW uses its internal 100 Hz clock signal,
that corresponds to a time resolution of 10  ms.

The motion simulator uses its own clock. Depending on the capabilities of the pro-
cessor (general purpose or real time) that the motion simulator uses, the processing
time and the accuracy of the clock can vary. The R&S SMW internal clock signal is pre-
cise and stable. This clock is not only used to generate the GNSS signals but is also
the time reference for the whole HIL setup.

Synchronization
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We recommend that you synchronize the motion simulator to the R&S SMW. Consider
the following:
● Follow the rules described in "Measures for proper operation" on page 10
● Always take the measures for latency calibration as described in Chapter 2.3,

"Latency calibration", on page 11.
● If your motion simulator can receive and process the marker signal of the

R&S SMW, generate a 1PPS (one pulse per second) or 10PPS (10 pulses per sec-
ond) marker signal. Feed the marker signal to the motion simulator.
If synchronized, the motion simulator sends the HIL commands right after each
1PPS marker signal.
Related settings:
– "GNSS > Marker > Marker Mode"

2.2  System latency

System latency is a term that describes the time it takes the R&S SMW to receive and
process an incoming HIL command, calculate, output and transmit the signal to the
GNSS receiver. The default system latency is 20 ms; this value corresponds to the
R&S SMW hardware processing time.

In the context of this description, the term latency (tcal.latency) describes the additional
latency (i.e. delay) caused, for example, by the transmission and processing time of
the HIL commands. If the system latency value is a constant parameter that cannot be
reduced, the additional latency tcal.latency is a variable value, that can be partly or fully
compensated. This description focuses on the measures to measure and compensate
for additional latency.

You can query the additional latency value as described in Chapter 2.3, "Latency cali-
bration", on page 11. The system latency and the latency are related as follows:

System Latency = tcal.latency + 0.02

The minimum system latency of the HIL setup is 2 ms and is achieved if the
tcal.latency = 0 ms. The situation when tcal.latency = 0 ms is referred as a zero latency situa-
tion; it is also the best case scenario.

See also:
● Chapter 2, "Tips for best results", on page 10
● "Understanding the response of the query SOURce:BB:GNSS:RT:RECeiver1:HIL-

Position:LATency:STATistics?" on page 25

2.3  Latency calibration

Latency calibration is the process of compensating the latency time. Calibrate the
latency at the beginning of the simulation and repeat the process periodically, every 5
or 10 seconds.

Latency calibration
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Initial latency calibration process

1. Synchronize the R&S SMW and the motion simulator.
(see Chapter 2.1, "Synchronization", on page 10).

2. Set the same initial position (P0) in both the motion simulator and the R&S SMW.
The initial position is the position in the moment t0.
In R&S SMW, set the receiver postion with the parameters "Receiver Position >
Location Coordinates".

Tip: We recommend that you use the position that you are going to use as the first
simulation position in the motion simulation.

3. Wait until the GNSS receiver performs its first position fix.

4. Retrieve an initial time reference information from the R&S SMW.
Send the command [:SOURce<hw>]:BB:GNSS:RT:HWTime? to query the
elapsed time from the simulation begin (ΔHW,0).

The response is a value that reflects the difference between the current time in the
R&S SMW (tGNSS,0) and the motion simulator (tMS,0) at the moment t0:

ΔHW,0 ≈ tMS,0 - tGNSS,0

Note: The retrieved value is a rough estimation. It does not consider the round-trip
time of the HIL commands.
Although not exact, the response of the command is suitable for the initial time
alignment (first approximation).
The precise calibration is performed with the next steps.

5. Send the first HIL command as a function of the moment tMS,1.
HIL commands define position Pi at a given moment of time tElapsedTime,i.
To compensate for the time difference between the R&S SMW and the motion sim-
ulator, correct the tElapsedTime,i value:

a) Calculate the first elapsed time tElapsedTime,1

tElapsedTime,1 = tMS,1 - ΔHW,0

b) Use the coordinates of the initial position P0

c) Send a remote command containing the timestamp with position and attitude
information.
If you use UDP packets, send the command &GTL first and then send the UDP
packets.
If you use SCPI commands, send the command depending on the position
coordinates:
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:
MODE:A for position data in ECEF coordinates.
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:
MODE:B for position data in NED coordinates.

6. Query the time difference (tcal.latency,i) between the elapsed time in the R&S SMW
(tHW,j) and the elapsed time in the last HIL command (tElapsedTime,i).

Latency calibration
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Send the command [:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:
HILPosition:LATency:STATistics?.
The query returns several parameters and statistical information. For more informa-
tion, see the description of the remote command.

Observe the value tcal.latency,1 = tHW,0 - tElapsedTime,1.
If UDP is used, send the &GTL command after the query.

7. If tcal.latency,i ≥ |System Latency - 20 ms|, perform the following:

a) Calculate ΔHW,j = ΔHW,j-1 + tcal.latency,i

Where:
● i reflects the HIL update rate
● j is the latency calibration iteration number

b) Calculate the elapsed time tElapsedTime,i+1 = tMS,i+1 - ΔHW,j

c) Send the subsequent HIL command as a function of tMS,i+1 and Pi

The latency is successfully calibrated, if one of the following is true:
● -10 ms < <MinLatency> < <MaxLatency>  < 10 ms
● <CmdReceived> = <CmdSync> + <CmdInterp>
● <MinUsed>min ≥ 1
Where <MaxLatency>, <MinLatency>, <MinUsed>, <CmdReceived>,
<CmdSync> and <CmdInterp> are the value returned by the query [:
SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:
STATistics?.
If UDP is used, send the &GTL command.
A latency of 0 ms corresponds to a system latency of 20 ms.
If the latency calibration is unsuccessful:
● Add a buffer time, see Chapter 2.4, "Adding a constant delay to compensate

for command jitter", on page 13.
● Query HIL statistical information and analyze the values of the parameters

<CmdExtrap> and <CmdPredict>.
They indicate the number of times the prediction algorithm has been applied,
see Chapter 2.6, "Trajectory prediction", on page 15.

2.4  Adding a constant delay to compensate for command
jitter

If the motion simulator is not equipped with a real-time processor, it can happen that it
sends the HIL commands with varying update rate. This effect is often referred as a
command jitter.

The R&S SMW can compensate command jitter in the range of 1 ms to 30 ms. The
mechanism is to add a buffer time tBuffer so that the R&S SMW has enough time to
process and realign the HIL commands. The drawback of this mechanism is the adding
of an extra constant delay to the system.

Adding a constant delay to compensate for command jitter
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Adding buffer time (tBuffer)

To compensate for the command jitter:

► Send the command [:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:
SLATency.

The command sets the system latency, i.e. a delay tDelay. The additional buffer time
tBuffer is calculated as follows:
tBuffer = tDelay - 0.02
Where tBuffer is the additional time available for processing.
The value 0.02 s is the hardware processing time of the R&S SMW.

If the value tBuffer > 0 ms, the system latency equation changes as follows:
System Latency = tcal.latency + tDelay = tcal.latency + tBuffer + 0.02

Finding out the best system latency value tDelay

1. Select the initial tDelay value depending on whether the motion simulator is equip-
ped with real-time processor or not:

● With real-time processor: <Delay> = 0.02 s
● Without real-time processor: <Delay> = 0.15 s

2. Collect statistical information with the query [:SOURce<hw>]:BB:GNSS:RT:
RECeiver[:V<st>]:HILPosition:LATency:STATistics? for at least 30
min.

3. Evaluate the absolute minimum value returned for the parameter <MinUsed>.

4. Reduce the tDelay value. Evaluate the statistics again.
Repeat this step until <MinUsed>min ≥ 1.

Example: 
If the R&S SMW and the motion simulator are connected in a HIL setup and:
● HIL update rate = 0.1 s
● tDelay = 0.05 s
● tBuffer = 0.03 s.

● In a non-synchronized setup with, for example, tcal.latency = 0.04 s, the current sys-
tem latency is:
System Latency = 0.04 + 0.05 = 0.09 s

● After the R&S SMW and the motion simulator are synchronized (tcal.latency = 0 s), the
system latency becomes:
System Latency = 0 + 0.05 = 0.05 s
With the buffer time of 0.03 s, R&S SMW tolerates command jitter of up to 0.03 s.
Because of the buffer time, prediction is not applied.

Adding a constant delay to compensate for command jitter
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Adding of buffering time does not substitute the latency calibration. It is an add-on to it.
Always calibrate the latency as described in Chapter 2.3, "Latency calibration",
on page 11.

Related settings:
● Chapter 2.2, "System latency", on page 11

2.5  Interpolation

If the update rate of the HIL commands is less than 100 Hz, the instrument interpolates
the two last received commands to achieve the required update rate. Interpolation can
be applied if the system latency is higher than the update rate and if at least one HIL
command was received and buffered. The former situation is present, if the query [:
SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:
STATistics? returns <MinUsed> = 1.

The interpolation mechanism can achieve a continuous signal and hence results in bet-
ter result than the extrapolation and the prediction methods (see Chapter 2.6, "Trajec-
tory prediction", on page 15).

2.6  Trajectory prediction

The R&S SMW tries to compensate for the latency (tcal.latency) by applying a prediction
algorithm. If the R&S SMW and the motion simulator are synchronized and the latency
is less than 10 ms, prediction is not applied. If the latency exceeds 10 ms, prediction is
applied. The R&S SMW uses the last received high-order dynamics (speed, accelera-
tion and jerk) and predicts or extrapolates the position of the motion simulator at the
subsequent update time.

Where:
● Extrapolation describes the process, where the position is calculated from a

received command with an old timestamp and is based on the received speed,
acceleration and jerk

● Prediction is applied if no command was received, for example if the update period
is larger than 10 ms. When predicted, subsequent positions are calculated based
on the last known speed, acceleration and jerk

Retrieving the number of automatically performed extrapolations and predic-
tions

You can query statistical information on the number of times the R&S SMW applied
predictions or extrapolation with the command [:SOURce<hw>]:BB:GNSS:RT:
RECeiver[:V<st>]:HILPosition:LATency:STATistics?.

Observe the values of the parameters <CmdExterp> and <CmdPredict>.

Trajectory prediction
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Example: How extrapolation can impair the results
Imagine that at the moment t0 a vehicle is moving with a velocity v = 1 m/s and it stops
(v = 0 m/s) after 0.1 s (t1 = t0 +  0.1 s).

If the latency exceeds 10 ms, then the R&S SMW projects the movement assuming
that the vehicle keeps its velocity v = 1 m/s. This result of position offset of 0.01 m.
At the next update period, for example 100 ms later, the R&S SMW receives the sub-
sequent command and the correct velocity v = 0 m/s. The instrument corrects the posi-
tion and removes the 0.01 m position offset.
This causes an abrupt change (a "jump") between the two consecutive positions.

As illustrated in the example, the prediction algorithm alone cannot assure that the tra-
jectory is continuous. Without further measures, the predicted positions can cause
abrupt changes between consecutive positions or lead to tracking loss of the GNSS
signal. The severity of these abrupt changes depends on both the latency value and
the current dynamics and therefore are tolerated or not by the GNSS receiver.

Prediction for instance is useful, if the application requires low latency and tolerates
"jumps". Otherwise, we recommend that you use real-time PC with synchronized
marker or add buffer to increase the system latency.

See Chapter 2, "Tips for best results", on page 10.

Trajectory prediction
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3  HIL settings
Option: R&S SMW-K109

Access:

1. Select "GNSS" > "Simulation Configuration" > "Receiver".

2. Select "Position" > "Remote Control (HIL)".

3. Select "Position Configuration".

Settings

Location, Initial Position................................................................................................ 17
Reference Frame.......................................................................................................... 19
Location Coordinates, Position Format......................................................................... 19
Attitude Behaviour, More...............................................................................................20
System Latency.............................................................................................................20
Interface Type............................................................................................................... 20
UDP Port....................................................................................................................... 20

Location, Initial Position
Selects the location or initial position depending on the simulated object:
● Static GNSS receiver ("Position > Static"):

Selects the geographic location of the GNSS receiver.
● R&S SMW-K109: Hardware in the loop (HIL) GNSS receiver ("Position > From

Remote"):
Selects the initial position of the GNSS receiver.

● R&S SMW-K122: Real-time kinematics (RTK) base station:
Selects the geographic location of the RTK base station.
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The representation of the coordinates depends on the selected "Reference Frame" and
"Position Format".
"User Defined" Sets the receiver position in terms of "Latitude", "Longitude" and "Alti-

tude"
"City" Selects a predefined geographic location, see Table 3-1 for an over-

view.
The parameters "Latitude", "Longitude" and "Altitude" are set auto-
matically.

Table 3-1: Coordinates of the simulated predefined positions

Continent City Latitude [deg] Longitude [deg] Altitude [m]

Europe London 51.500625 -0.1246219 22

 Moscow 55.7522222 37.6155556 200

 Munich 48.15 11.5833333 508

 Paris 48.8584 2.2946278 66

America New York 40.714667 -74.0063889 1

 San Francisco 37.8194389 -122.4784939 35

 Anchorage 61.2166667 -149.8833333 115

 Mexico City 19.4510539 -99.1255189 2310

 Bogota 4.7111111 -74.0722222 2640

 Sao Paulo -23.5337731 -46.62529 760

 Santiago de Chile -33.4474869 -70.6736758 522

Asia Beijing 39.9055556 116.3913889 60

 New Delhi 28.6138889 77.2088889 77

 Seoul 37.5514997 126.9877939 265

 Singapore 1.3113108 103.8268528 110

 Taipei 25.0223439 121.5147581 10

 Tokyo 35.6838611 139.7450581 45

Africa Cairo 30.0444419 31.2357117 23

 Dakar 14.7166769 -17.4676858 22

 Cape Town -33.9188611 18.4233 6

Australia Sydney -33.8833333 151.2166667 3

 Perth -31.9535119 115.8570481 2

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog
on page 34
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect]
on page 33
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Reference Frame
For GNSS receiver, selects the reference frame used to define the receiver coordi-
nates. The transformation between the reference frames is performed automatically.
The following applies:
● XWGS84 = (1 - 0.008*10-6)*XPZ 90 - 0.2041*10-7*YPZ 90 + 0.1716*10-7*ZPZ 90 - 0.013
● YWGS84 = (1 - 0.008*10-6)*YPZ 90 - 0.2041*10-7*XPZ 90 + 0.1115*10-7*ZPZ 90 + 0.106
● ZWGS84 = (1 - 0.008*10-6)*ZPZ 90 - 0.1716*10-7*XPZ 90 - 0.1115*10-7*YPZ 90 + 0.022

Both reference frames are ECEF frames with a set of associated parameters.
"WGS-84" The World Geodetic System WGS-84 is the reference frame used by

GPS.
"PZ 90.11 (GLONASS)"

Parametry Zemli PZ (Parameters of the Earth) is the reference frame
used by GLONASS.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
RFRame on page 34

Location Coordinates, Position Format
In the ECEF coordinate system, a geographic location is identified by three coordi-
nates, the altitude, latitude and longitude. The last two can be displayed in decimal or
DMS format. The display format is determined by the parameter "Position Format".

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degrees"
The display format is decimal degrees, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the altitude of the reference location. The altitude value is the height
above the ellipsoid (HAE), that is the reference ellipsoid (WGS84 or PZ90).

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

Altitude, latitude and longitude are configurable, if "Location, Initial Position > User
Defined".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
FORMat on page 34
To enter the coordinates in "Position Format > DEG:MIN:SEC"
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:
PZ on page 35
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DMS[:WGS] on page 35
To enter the coordinates in "Position Format > Decimal Degrees"
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal:PZ on page 34
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal[:WGS] on page 34

Attitude Behaviour, More
Defines how the attitude information is defined.
"From Remote"

Option: R&S SMW-K109
For "Receiver" > "Position" > "Remote Control (HIL)", the attitude
parameters are set by the received HIL commands. The selection is
suspended.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]
on page 36

System Latency
Option: R&S SMW-K109
System latency is the time period, which the R&S SMW needs to receive and process
incoming HIL commands.
The minimum value of 20 ms corresponds to the R&S SMW hardware processing time.
Values higher than 20 ms constitute a delay or a buffer time to process incoming HIL
position data.
The parameter is crucial for latency calibration between the R&S SMW and the control
application program.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:SLATency on page 32

Interface Type
Option: R&S SMW-K109
Two interface types are provided for the HIL communication between the R&S SMW
and the control application program, which remotely controls the R&S SMW:

"SCPI" A SCPI connection is used for communication.
In some case, the Transfer Control Protocol (TCP) can suffer from the
overhead caused by the acknowledgments and retransmission. In
such cases, enable the socket option "TCP_NODELAY" on the sender
side.

"UDP Raw Socket"
The R&S SMW listens to a unidirectional UDP stream, generated by
the control application program.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:ITYPe on page 32

UDP Port
Option: R&S SMW-K109
Requires "Interface Type" > "UDP Raw Socket".
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Sets the port for incoming UDP packets at the R&S SMW.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:PORT on page 32
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4  UDP position data
Compared to the SCPI interface, the User Data Protocol (UDP) offers the following two
advantages:
● UDP is known to have less communication overhead, and therefore recommended

in time critical simulations.
● The user interface is not blocked (remote state) like when using the SCPI interface.

Thus, using UDP you can change the satellite states, power offset and pseudor-
ange bias on-the-fly.

Table 4-1 shows the structure of a UDP data packet containing position data. The posi-
tion data is provided in a binary format as specified in the IEEE Standard 754 for
Binary Floating-Point Arithmetic.

The measures for proper operation use the SCPI interface and require remote control.
After calibration and for retrieving position data via UDP, you have to switch the
R&S SMW from remote state to manual state.
On the control application, use the command &GTL for this purpose.

Table 4-1: UDP packet and parameter description for HIL position data

Data Type Size Parameter Description Default unit

integer 4 bytes reserve0 - -

integer 4 bytes reserve1   

integer 4 bytes reserve2   

integer 4 bytes reserve3   

double 8 bytes ElapsedTime Elapsed time since the simulation start s

double
double
double

8 bytes

8 bytes

8 bytes

<X>
<Y>
<X>

Coordinate in the Earth Fixed Earth Cen-
tered (ECEF) coordinate system

m

double
double
double

8 bytes

8 bytes

8 bytes

<XDot>
<YDot>
<ZDot>

Velocity vector in ECEF

(equivalently <Vx>, <Vy>, <Vz>)

m/s

double
double
double

8 bytes

8 bytes

8 bytes

<XDotDot>
<YDotDot>
<ZDotDot>

Acceleration vector in ECEF

(equivalently <Ax>, <Ay>, <Az>)
m/s2

double
double
double

8 bytes

8 bytes

8 bytes

<XDotDotDot>
<YDotDotDot>
<ZDotDotDot>

Jerk vector in ECEF

(equivalently <Jx>, <Jy>, <Jz>)
m/s3

double
double
double

8 bytes

8 bytes

8 bytes

<Yaw>
<Pitch>
<Roll>

Attitude angles

(yaw/heading, pitch/elevation, roll/bank)

Unlimited value range to simulate more than
one cycle rotation between two updates

rad

http://ieeexplore.ieee.org/document/30711/?anchor=definitions
http://ieeexplore.ieee.org/document/30711/?anchor=definitions
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Data Type Size Parameter Description Default unit

double
double
double

8 bytes

8 bytes

8 bytes

<YDot>
<PDot>
<RDot>

Attitude angular rate of change rad/s

double
double
double

8 bytes

8 bytes

8 bytes

<YDotDot>
<PDotDot>
<RDotDot>

Attitude angular second order derivative rad/s2

double
double
double

8 bytes

8 bytes

8 bytes

<YDotDotDot>
<PDotDotDot>
<RDotDotDot>

Attitude angular third order derivative rad/s3
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5  SCPI position data
During remote operation, the control application program sends real-time HIL (SCPI)
commands to the R&S SMW. The HIL commands are sent with low and varying time
resolution. This time resolution is also referred as a HIL update rate. It is typically a
value from 10 Hz to 100 Hz (or 10 ms and 100 ms) and depends on the motion simula-
tor, in particular on its real-time capabilities.

HIL position data is provided by two commands:

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B
The command defines the HIL position, motion (velocity, acceleration, jerk) and attitude
at a specific moment of time. The position is defined by earth centered earth fixed
(ECEF) coordinates for mode A and by north east down (NED) coordinates for mode
B. The moment of time is given as a time offset (<ElapsedTime>) from the simulation
time start.
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6  Remote-Control Commands
Option: R&S SMW-K109

The following commands are required for signal generation with the satellite navigation
option HIL in a remote environment. We assume that the R&S SMW has already been
set up for remote operation in a network as described in the R&S SMW documentation.
A knowledge about the remote control operation and the SCPI command syntax are
assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMW user manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1] to 4 available baseband signals

V<st>
V<us>

1 to 2 number of simulated vechicles

Example: Setting the initial position of a receiver
// Select a user-defined position.
SOURce1:BB:GNSS:RECeiver:V1:LOCation:CATalog?
// Respone: "User Defined, Waypoints, New York, .."
SOURce1:BB:GNSS:RECeiver:V1:LOCation:SELect "User Defined"

SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:RFRame WGS84
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:FORMat DMS
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:DMS:WGS?
// 11,35,0,EAST,48,9,0,NORT,508
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:FORMat DEC
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:DEC:WGS?
// 11.583333,48.150000,508

Understanding the response of the query SOURce:BB:GNSS:RT:RECeiver1:HIL-
Position:LATency:STATistics?

The following are three examples that illustrate how the HIL update rate and the buffer
time influence the way the received HIL commands are processed.

The query is sent each 5 s as indicated by the difference between two subsequently
<CmdHwTime> values.

The response of each individual query is a string. The set of strings per example have
been converted to a *.csv file and formatted for better understanding.
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Example: Non-real-time (RT) processor, HIL update rate = 100 Hz, tDelay = 0.02 s

Figure 6-1: Example of latency statistics

1 = Varying latency of up to 50 ms
2 = Number of non-zero latency values varies
3 = Number of commands received during each period = 500
4 = Not all received commands are used (<CmdUsed> < <CmdReceived>)
5 = Not all commands are applied at their specified time (<CmdSync> < <CmdUsed>)
6 = Interpolation not applied; commands do not arrive in advance
7 = Number of times the prediction algorithm was applied

Example: Non-real-time (RT) processor, HIL update rate = 100 Hz, tDelay = 0.15 s
This example illustrates that the increased tDelay improves the number of processed HIL
commands. The system latency however also increases.

Figure 6-2: Impact of the increased t_Delay

1 = All commands are used synchronous
2 = Interpolation or prediction is not necessary and not applied
3 = Increased number of buffered commands; the values indicate that there is a room to decrease (optimize)

the tDelay (see Chapter 2.4, "Adding a constant delay to compensate for command jitter", on page 13)

Example: Non-real-time (RT) processor, HIL update rate = 10 Hz, tDelay = 0.15 s
This example illustrates that varying the HIL update rate while keeping the same tDelay

also improves the HIL command processing. The generated signal is continuous. The
system latency however also increases.

Figure 6-3: Impact of the reduced HIL update rate

1 = All commands are used synchronous
2 = Interpolation is required and applied (ideal situation where each HIL command is executed synchronous

and there are enough HIL commands to interpolate the values from)
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The last two examples show approaches that are suitable if your system tolerates sys-
tem delays.

Related commands

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A..................................27
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B..................................28
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency?................................ 29
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:STATistics?.................30
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:SLATency................................................ 32
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:ITYPe......................................................32
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:PORT......................................................32
[:SOURce<hw>]:BB:GNSS:RT:HWTime?............................................................................33
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect]..........................................33
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog.......................................... 34
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:RFRame.................... 34
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:FORMat.....................34
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal:PZ............... 34
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal[:WGS]..........34
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:PZ.....................35
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS[:WGS]............... 35
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]......................................36

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
<ElapsedTime>, <X>, <Y>, <Z>, <XDot>, <YDot>, <ZDot>, <XDotDot>,
<YDotDot>, <ZDotDot>, <XDotDotDot>, <YDotDotDot>, <ZDotDotDot>, <Yaw>,
<Pitch>, <Roll>, <YawDot>, <PitchDot>, <RollDot>, <YawDotDot>,
<PitchDotDot>, <RollDotDot>, <YawDotDotDot>, <PitchDotDotDot>,
<RollDotDotDot>

Sets hardware in loop (HIL) position, motion (velocity, acceleration, jerk) and attitude in
Earth Fixed Earth Centered ECEF coordinates.

The yaw/heading, pitch/elevation, roll/bank rotation angles and their derivatives are
obtained by rotating the body (XYZ) frame. The frame is rotated starting from an
aligned state with the local NED frame. Three consecutive Euler rotations are: around
the z axis, the y axis and the x axis.
Table 6-1: SCPI parameter description

Parameter  Description Default unit

<X>,<Y>,<Z> Mandatory Coordinate in the Earth Fixed Earth Centered (ECEF)
coordinate system

m

<XDot>,<YDot>,
<ZDot>

Mandatory Velocity vector in ECEF (equivalently Vx, Vy, Vz) m/s

<XDotDot>,
<YDotDot>,
<ZDotDot>

Mandatory Acceleration vector in ECEF (equivalently Ax, Ay,
Az)

m/s2

<XDotDotDot>,
<YDotDotDot>,
<ZDotDotDot>

Mandatory Jerk vector in ECEF (equivalently Jx, Jy, Jz) m/s3
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Parameter  Description Default unit

[<Yaw>,<Pitch>,
<Roll>]

Optional Attitude angles (yaw/heading, pitch/elevation, roll/bank)

Unlimited value range to simulate more that one cycle
rotation between two updates

rad

[<YDot>,<PDot>,
<RDot>]

Optional Attitude angular rate of change rad/s

[<YDotDot>,
<PDotDot>,
<RDotDot>]

Optional Attitude angular second order derivative rad/s2

[<YDotDotDot>,
<PDotDotDot>,
<RDotDotDot>]

Optional Attitude angular third order derivative rad/s3

See also Chapter 2.3, "Latency calibration", on page 11.

For HIL mode A, position data can also be retrieved via UDP packets, see Chapter 4,
"UDP position data", on page 22.

Parameters:
<ElapsedTime> float

Elapsed time from the simulation start, as queried with the com-
mand [:SOURce<hw>]:BB:GNSS:RT:HWTime?.
For description of the other parameters, see Table 6-1.
Range: 0  to  99999999

Usage: Setting only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B
<ElapsedTime>, <Latitude>, <Longitude>, <Altitude>, <NDot>, <EDot>, <DDot>,
<NDotDot>, <EDotDot>, <DDotDot>, <NDotDotDot>, <EDotDotDot>,
<DDotDotDot>, <Yaw>, <Pitch>, <Roll>, <YawDot>, <PitchDot>, <RollDot>,
<YawDotDot>, <PitchDotDot>, <RollDotDot>, <YawDotDotDot>,
<PitchDotDotDot>, <RollDotDotDot>

Sets hardware in loop (HIL) position, motion (velocity, acceleration, jerk) and attitude in
North East Down (NED) coordinates.

The yaw/heading, pitch/elevation, roll/bank rotation angles and their derivatives are
obtained by rotating the body (XYZ) frame. The frame is rotated starting from an
aligned state with the local NED frame. Three consecutive Euler rotations are: around
the z axis, the y axis and the x axis.
Table 6-2: Parameter description

Parameter  Description Default unit

<Latitude>,
<Longitude>,
<Altitude>

Mandatory Geodetic location °

<NDot>,<EDot>,
<DDot>

Mandatory Velocity vector in the North East Down (NED) coordi-
nate system (equivalently Vn, Ve, Vd)

m/s
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Parameter  Description Default unit

<NDotDot>,
<EDotDot>,
<DDotDot>

Mandatory Acceleration vector in NED (equivalently An, Ae, Ad) m/s2

<NDotDotDot>,
<EDotDotDot>,
<DDotDotDot>

Mandatory Jerk vector in NED (equivalently Jn, Je, Jd) m/s3

[<Yaw>,<Pitch>,
<Roll>]

Optional Attitude angles (yaw/heading, pitch/elevation, roll/bank)

Unlimited value range to simulate more that one cycle
rotation between two updates

rad

[<YDot>,<PDot>,
<RDot>]

Optional Attitude angular rate of change rad/s

[<YDotDot>,
<PDotDot>,
<RDotDot>]

Optional Attitude angular second order derivative rad/s2

[<YDotDotDot>,
<PDotDotDot>,
<RDotDotDot>]

Optional Attitude angular third order derivative rad/s3

See also Chapter 2.3, "Latency calibration", on page 11.

This mode is currently supported for position data retrieved via SCPI commands only.
For HIL mode A, position data can also be retrieved via UDP packets, see Chapter 4,
"UDP position data", on page 22.

Parameters:
<ElapsedTime> float

Elapsed time from the simulation start, as queried with the com-
mand [:SOURce<hw>]:BB:GNSS:RT:HWTime?.
For description of the other parameters, see Table 6-2.
Range: 0  to  99999999

Usage: Setting only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency?

Queries the predicted latency that is the time delay between the elapsed time of HIL
mode command and the time to execute this command in the R&S SMW. HIL com-
mand refers to HiL mode A or HiL mode B commands:

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B
How to: Chapter 2.3, "Latency calibration", on page 11
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Return values: 
<Latency> float

Range: min  to  max
Increment: 0.001
*RST: 0
Default unit: s

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:
STATistics?

Queries the current latency tcal.latency,i and statistics on the latency values.

This command returns also the minimum deviation and the maximum deviation from
zero latency. Also, it returns the measured number of non-zero latency values since
the last query with this command.

The following terms are used:
● HIL command refers to HiL mode A or HiL mode B commands:

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B

● Dropped commands are commands that are evaluated, buffered but not applied
because they become outdated as more up-to-date information is received

● Return values apply for the period since the last query with this command.

How to: Chapter 2.3, "Latency calibration", on page 11

Return values: 
<CmdHwTime> float

The hardware time at the moment the last HIL command is
received.
Increment: 0.001
*RST: 0

<LastLatency> float
Time delay between the time specified with the parameter
<ElapsedTime> in a HIL command and the time this command
is executed in the R&S SMW.
Increment: 0.001
*RST: 0
Default unit: s

<MaxLatency> float
The largest latency value since the last time this query was sent.
Increment: 0.001
*RST: 0
Default unit: s
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<MinLatency> float
The smallest latency value since the last time this query was
sent.
Increment: 0.001
*RST: 0
Default unit: s

<NoZeroValues> integer
Number of non-zero latency values since the last time this query
was sent.
*RST: 0

<CmdReceived> integer
Accumulated <LastLatency> values since the last time this
query was sent.
*RST: 0

<CmdUsed> integer
The number of used HIL commands, excluding the dropped HIL
commands, since the last time this query was sent.
*RST: 0

<CmdSync> integer
The number of HIL commands applied at their specified time
*RST: 0

<CmdExterp> integer
The number of extrapolated HIL commands. The commands are
applied later than their specified time.
*RST: 0

<CmdInterp> integer
The number of internal position updates.
The value includes commands describing both situations,
moment of time in past and moment of time in the future.
*RST: 0

<CmdPredict> integer
The number of internal position updates performed by the pre-
diction algorithm, see Chapter 2.6, "Trajectory prediction",
on page 15.
*RST: 0

<MaxUsed> integer
The maximum number buffered commands
*RST: 0
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<MinUsed> integer
The minimum number buffered commands
*RST: 0

Example: See "Understanding the response of the query
SOURce:BB:GNSS:RT:RECeiver1:HILPosition:LATency:STATis-
tics?" on page 25.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:SLATency <SystemLatency>

Sets the time delay between the time specified with the parameter <ElapsedTime> in
the HIL mode A position data command and the time this command is executed in the
R&S SMW.

See also Chapter 2.2, "System latency", on page 11.

You can use the retrieved value for latency calibration, see Chapter 2.3, "Latency cali-
bration", on page 11.

Parameters:
<SystemLatency> float

Range: 0.02  to  0.15
Increment: 0.001
*RST: 0.02
Default unit: s

Example: See "Understanding the response of the query
SOURce:BB:GNSS:RT:RECeiver1:HILPosition:LATency:STATis-
tics?" on page 25.

Manual operation: See "System Latency" on page 20

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:ITYPe <InterfaceType>

Set the interface type for the remote communication between R&S SMW and the con-
trol application.

Parameters:
<InterfaceType> SCPI | UDP

*RST: SCPI

Example: SOURce1:BB:GNSS:RECeiver:V1:HIL:ITYPe UDP

Manual operation: See "Interface Type" on page 20

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:PORT <UdpPort>

Set the UDP port number at the R&S SMW for the HIL interface.
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Parameters:
<UdpPort> integer

Range: 0  to  65535
*RST: 7755

Example: SOURce1:BB:GNSS:RECeiver:V1:HIL:PORT 7756

Manual operation: See "UDP Port" on page 20

[:SOURce<hw>]:BB:GNSS:RT:HWTime?

Queries the time elapsed since the simulation start.

To query the simulation start time, use the command:

[:SOURce<hw>]:BB:GNSS:TIME:STARt:TIME
Return values: 
<ElapsedTime> float

Range: 0  to  max
Increment: 0.001
*RST: 0
Default unit: s

Example: See [:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:
HILPosition:MODE:A on page 27.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect] <Location>

Selects the geographic location of the GNSS receiver.

Parameters:
<Location> string

User Defined
Enables the definition of the "Latitude", "Longitude" and "Alti-
tude" of the GNSS receiver with fixed position in the ECEF
WGS84 coordinate system.
"<City>"
Selects one of the predefined geographic locations, see
Table 3-1. The parameters latitude, longitude and altitude are set
according to the selected position.

Example: See Example"Setting the initial position of a receiver"
on page 25.

Manual operation: See "Location, Initial Position" on page 17



Remote-Control CommandsR&S®SMx-K109

34User Manual 1178.8394.02 ─ 10

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog

Queries the names of predefined geographic locations of the GNSS receiver. The
query returns a comma-separated list of available locations.

For predefined geographic locations, see Table 3-1.

Example: See Example"Setting the initial position of a receiver"
on page 25.

Manual operation: See "Location, Initial Position" on page 17

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:RFRame
<ReferenceFrame>

Selects the reference frame used to define the receiver coordinates.

Parameters:
<ReferenceFrame> PZ90 | WGS84

*RST: WGS84

Manual operation: See "Reference Frame" on page 19

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:FORMat
<PositionFormat>

Sets the format in which the latitude and longitude are set.

Parameters:
<PositionFormat> DMS | DECimal

*RST: DMS

Example: See Example"Setting the initial position of a receiver"
on page 25.

Manual operation: See "Location Coordinates, Position Format" on page 19

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal:
PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal[:
WGS] <Longitude>, <Latitude>, <Altitude>

Defines the coordinates of the geographic location of the GNSS receiver in decimal for-
mat.

Parameters:
<Longitude> float

Defines the longitude.
Range: -180  to  180
Increment: 1E-7
*RST: 0
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<Latitude> float
Defines the latitude.
Range: -90  to  90
Increment: 1E-7
*RST: 0

<Altitude> float
Defines the altitude. The altitude value is in meters and is the
height above the reference ellipsoid.
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Manual operation: See "Location Coordinates, Position Format" on page 19

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:PZ
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS[:
WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

Defines the coordinates of the geographic location of the GNSS receiver in degrees,
minutes and seconds.

Parameters:
<LongitudeDeg> integer

Defines the longitude degrees.
Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
*RST: 0
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<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

<Altitude> float
Defines the altitude. The altitude value is in meters and is the
height above the reference ellipsoid.
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Manual operation: See "Location Coordinates, Position Format" on page 19

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]
<AtitudeBehaviou>

Defines how the attitude information is defined.

Parameters:
<AtitudeBehaviou> CONStant | FILE | MOTion | SPINning | REMote

FILE enabled if smoothing is not used.

Options: CONStant | FILE | MOTion | SPINning require R&S SMW-K108
REMote requires R&S SMW-K109

Manual operation: See "Attitude Behaviour, More" on page 20
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List of commands
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